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Instructional icons
Before you start, familiarise yourself with the icons 
you will see in this manual: 

Warning—situations that could cause 
injury to yourself or others

Caution—situations that could cause 
damage to your phone or other equipment

Note—notes, usage tips, or additional 
information 

 Refer to—pages with related information; 
for example:  p.12 (represents “see page 
12”)
using this
manual

This user manual has been specially designed to
guide you through the functions and features of your

mobile phone. To get started quickly,
refer to “introducing your mobile phone,”

“assembling and preparing your mobile phone,”
and “using basic functions.”



using this m
anual
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Copyright information
Rights to all technologies and products that 
comprise this device are the property of their 
respective owners:

• Bluetooth® is a registered trademark of the 
Bluetooth SIG, Inc. worldwide—Bluetooth QD 
ID: B0xxxxx.

• Java™ is a trademark of Sun Microsystems, Inc.
• Windows Media Player® is registered trademark 

of Microsoft Corporation.
→ Followed by—the order of options or 
menus you must select to perform a step; 
for example: Press the Confirm key→ 
Messages → Create message 
(represents Menu, followed by 
Messages, followed by Create message)

[ ] Square brackets—phone keys; for 
example: [ ] (represents the Power/ 
Menu exit key)

< > Angled brackets—softkeys that control 
different functions at each screen; for 
example: <OK> (represents the OK 
softkey)
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Keep your phone away from small 
children and pets
Keep your phone and all accessories out of the 
reach of small children or animals. Small parts may 
cause choking or serious injury if swallowed.

Protect your hearing

Safety warnings

Listening to a headset at high volumes 
can damage your hearing. Use only the 
minimum volume setting necessary to 
hear your conversation or music.
safety and
usage

information
 Comply with the following precautions to avoid
dangerous or illegal situations and ensure peak

performance of your mobile phone.
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• Never place batteries or phones on or in heating 
devices, such as microwave ovens, stoves, or 
radiators. Batteries may explode when 
overheated.

• Never crush or puncture the battery. Avoid 
exposing the battery to high external pressure, 
which can lead to an internal short circuit and 
overheating.

Avoid interference with pacemakers
Maintain a minimum of 15 cm (6 inches) between 
mobile phones and pacemakers to avoid potential 
interference, as recommended by manufacturers 
and the independent research group, Wireless 
Technology Research. If you have any reason to 
suspect that your phone is interfering with a 
pacemaker or other medical device, turn off the 
phone immediately and contact the manufacturer of 
the pacemaker or medical device for guidance.
Install mobile phones and equipment 
with caution
Ensure that any mobile phones or related equipment 
installed in your vehicle are securely mounted. Avoid 
placing your phone and accessories near or in an air 
bag deployment area. Improperly installed wireless 
equipment can cause serious injury when air bags 
inflate rapidly.

Handle and dispose of batteries and 
chargers with care
• Use only Samsung-approved batteries and 

chargers specifically designed for your phone. 
Incompatible batteries and chargers can cause 
serious injuries or damage to your phone.

• Never dispose of batteries or phone in a fire. 
Follow all local regulations when disposing used 
batteries or phone.



Drive safely at all times
Avoid using your phone while driving and obey all 
regulations that restrict the use of mobile phones 
while driving. Use hands-free accessories to 
increase your safety when possible.

Follow all safety warnings and 
regulations
Comply with any regulations that restrict the use of a 
mobile phone in a certain area.

Use only Samsung-approved 
accessories
Using incompatible accessories may damage your 
phone or cause injury.

Safety precautions
6

safety and usage inform
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Turn off the phone in potentially 
explosive environments
Do not use your phone at refuelling points (service 
stations) or near fuels or chemicals. Turn off your 
phone whenever directed by warning signs or 
instructions. Your phone could cause explosions or 
fire in and around fuel or chemical storage and 
transfer areas or blasting areas. Do not store or carry 
flammable liquids, gases, or explosive materials in 
the same compartment as the phone, its parts, or 
accessories.

Reduce the risk of repetitive motion 
injuries
When sending text messages or playing games on 
your phone, hold the phone with a relaxed grip, 
press the keys lightly, use special features that 
reduce the number of keys you have to press (such 
as templates and predictive text), and take frequent 
breaks.
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Protect batteries and chargers from 
damage
• Avoid exposing batteries to very cold or very hot 

temperatures (below 0° C/32° F or above 45° C/
113° F). Extreme temperatures can reduce the 
charging capacity and life of your batteries.

• Prevent batteries from contacting metal objects, 
as this can create a connection between the + 
and - terminals of your batteries and lead to 
temporary or permanent battery damage.

• Never use a damaged charger or battery.

Handle your phone carefully and 
sensibly
• Do not allow your phone to get wet—liquids can 

cause serious damage. Do not handle your 
phone with wet hands. Water damage to your 
phone can void your manufacturer’s warranty.
Turn off the phone near medical 
equipment
Your phone can interfere with medical equipment in 
hospitals or health care facilities. Follow all 
regulations, posted warnings, and directions from 
medical personnel.

Turn off the phone or disable the 
wireless functions when in an aircraft
Your phone can cause interference with aircraft 
equipment. Follow all airline regulations and turn off 
your phone or switch to a mode that disables the 
wireless functions when directed by airline 
personnel.



Avoid interference with other electronic 
devices
Your phone emits radio frequency (RF) signals that 
may interfere with unshielded or improperly shielded 
electronic equipment, such as pacemakers, hearing 
aids, medical devices, and other electronic devices 
in homes or vehicles. Consult the manufacturers of 
your electronic devices to solve any interference 
problems you experience.
8
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• Avoid using or storing your phone in dusty, dirty 
areas to prevent damage to moving parts.

• Your phone is a complex electronic device—
protect it from impacts and rough handling to 
avoid serious damage.

• Do not paint your phone, as paint can clog 
moving parts and prevent proper operation.

• Avoid using the phone’s camera flash or light 
close to the eyes of children or animals.

• Your phone and memory cards may be damaged 
by exposure to magnetic fields. Do not use 
carrying cases or accessories with magnetic 
closures or allow your phone to come in contact 
with magnetic fields for extended periods of time.
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• Disconnect chargers from power sources when 
not in use.

• Use batteries only for their intended purpose.

Handle SIM cards and memory cards 
with care
• Do not remove a card while the phone is 

transferring or accessing information, as this 
could result in loss of data and/or damage to the 
card or phone.

• Protect cards from strong shocks, static 
electricity, and electrical noise from other devices.

• Frequent writing and erasing will shorten the life 
span of memory cards.

• Do not touch gold-coloured contacts or terminals 
with your fingers or metal objects. If dirty, wipe the 
card with a soft cloth.
Use your phone in the normal position
Avoid contact with your phone’s internal antenna.

Allow only qualified personnel to service 
your phone
Allowing unqualified personnel to service your phone 
may result in damage to your phone and will void 
your warranty.

Ensure maximum battery and charger 
life
• Avoid charging batteries for more than a week, as 

overcharging may shorten battery life.
• Over time, unused batteries will discharge and 

must be recharged before use.

Important usage information
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Unpack
Check your product box for the following items:

• Mobile phone
• Battery
• Travel adapter (charger)
• User manual 

The items supplied with your phone may vary 
depending on the software and accessories 
available in your region or offered by your 
service provider.
You can obtain additional accessories from 
your local Samsung dealer.
introducing your
mobile phone

 In this section, learn about your mobile phone’s
layout, keys, display, and icons.



introducing your m
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he rear of your phone includes the following keys 
nd features:

You can lock the keys to prevent any unwanted 
phone operations from accidentally pressing 
any of the keys. In Idle mode, press and hold 
[ ] and select <Yes>. To unlock the keys, 
press <Unlock> → [ ].

Camera key

Flash key

Camera lens

Battery cover

Internal antenna
Phone layout
The front of your phone includes the following keys 
and features:

T
a

Power/Menu 
exit key

Alphanumeric 
keys

Volume key

Dial key

Left softkey

4-way 
navigation key

Right softkey

Earpiece

Display

Flashbulb

Mouthpiece

Camera lens 
for video calls

Confirm key

Special function 
keys

Multifunction jack



Keys

• Make sure that the multifunction 
jack cover is closed tightly.

• Always keep the multifunction jack 
cover clean and be careful to 
avoid damaging it.

Key Function

Softkeys Perform actions indicated at the 
bottom of the display

4-way 
navigation

In Idle mode, access user-defined 
menus; In Menu mode, scroll 
through menu options
12

introducing your m
obile phone

Maintain your water and dust resistant 
feature
Your phone is resistant to water and dust when all 
compartments are closed tightly. Your phone is not 
waterproof, so follow these tips carefully to prevent 
damage to your phone.

• Do not immerse the phone in 
water or use it in the rain.

• Do not expose the phone to salt 
water or ionised water, or to high 
water pressure.

• If the phone gets wet, dry it 
thoroughly with a clean soft cloth.
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Special 
function

Enter special characters or perform 
special functions; In Idle mode, 
press and hold [ ] for the Silent 
profile; In Idle mode, press and 
hold [ ] to lock the keys; From the 
dialling screen, press and hold [ ] 
to enter a pause between 
numbers

Volume Adjust the phone’s volume

Flash Turn the flash on or off (press and 
hold)

Camera

In Idle mode, turn on the camera 
(press and hold); In Camera mode, 
take a photo or record a video; 
From the dialling screen, make a 
video call

Key Function
Confirm

In Idle mode, access Menu mode; 
In Menu mode, select the 
highlighted menu option or confirm 
an input

Dial
Make or answer a call; In Idle 
mode, retrieve recently dialled, 
missed, or received numbers

Power/
Menu exit

Turn the phone on and off (press 
and hold); End a call; In Menu 
mode, cancel input and return to 
Idle mode

Alpha-
numeric

Enter numbers, letters and special 
characters; In Idle mode, press 
and hold [1] to access voice mails 
and [0] to enter an international call 
prefix

Key Function



Icons
Learn about the icons that appear on your display.

Icon Definition

Signal strength

SOS message feature activated

GPRS network connected

Transferring data in GPRS network

EDGE network connected

Transferring data via EDGE network

UMTS network connected

Transferring data via UMTS network

Voice call in progress

Video call in progress
14
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Display
Your phone’s main display consists of three areas:

Icon line
Displays various icons

Text and graphic area
Displays messages, 
instructions, and 
information you enter

Softkey line
Displays the current actions 
assigned to each softkey

Select  Back
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Connecting to secured web page

Call diverting activated

Roaming (outside of normal service area)

Normal profile activated

Silent profile activated

Driving profile activated

Meeting profile activated

Outdoor profile activated

Offline profile activated

New text message (SMS)

New multimedia message (MMS)

New email message

Icon Definition

Bluetooth hands-free car kit or headset 
connected

Music playback in progress

Music playback paused

Music playback stopped

FM radio on

FM radio suspended

Bluetooth activated

Connected with PC

Alarm activated

Memory card inserted

Browsing the web

Icon Definition
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introducing your m
obile phone

New voice mail message

New push message

New configuration message

Text message full

Multimedia message full

Email message full

Voice mail message full

Push message full

Configuration message full

Battery power level

Icon Definition
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assem
bling and preparing your m

obile phone
nstall the SIM or USIM card and 
attery
hen you subscribe to a cellular service, you will 

eceive a Subscriber Identity Module, or SIM card, 
ith subscription details, such as your personal 

dentification number (PIN) and optional services. To 
se UMTS services, you can purchase a Universal 
ubscriber Identity Module (USIM) card.

o install the SIM or USIM card and battery,

. Remove the battery cover.

If the phone is on, press and hold [ ] to turn 
it off.
assembling and
preparing your
mobile phone

 Get started by assembling and setting up
 your mobile phone for its first use.

I
b
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3. Insert the battery.

4. Replace the battery cover.
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2. Insert the SIM or USIM card.

Place the SIM or USIM card in the phone with 
the gold-coloured contacts facing down.



assem
bling and preparing your m

obile phone
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2. Plug the large end of the travel adapter into a 
power outlet.

3. When the battery is fully charged (the  icon is 
no longer moving), unplug the travel adapter from 
the power outlet.

4. Unplug the travel adapter from the phone.

5. Close the cover to the multifunction jack.

About the low battery indicator
When your battery is low, the phone will emit a 
warning tone and a low battery message. The 
battery icon will also be empty and blinking. If 
the battery level becomes too low, the phone 
will automatically power off. Recharge your 
battery to continue using your phone.
Charge the battery
Before using the phone for the first time, you must 
charge the battery.

1. Open the cover to the multifunction jack and plug 
the small end of the travel adapter.

Improperly connecting the travel adapter can 
cause serious damage to the phone. Any 
damages by misuse are not covered by the 
warranty.

With the triangle
facing up



3. Lift the memory card cover and insert a memory 
card with the label side facing up.

4. Close and lock the memory card cover.
20
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bling and preparing your m

obile phone

Insert a memory card (optional)
To store additional multimedia files, you must insert a 
memory card. Your phone accepts microSD™ 
memory cards up to 8 GB (depending on memory 
card manufacturer and type).

1. Remove the battery cover.

2. Unlock the memory card cover.
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using basic functions
Turn your phone on and off
To turn your phone on,

1. Press and hold [ ]. 

2. Enter your PIN and press <Confirm> 
(if necessary).

To turn your phone off, repeat step 1 above.

Switch to the Offline profile
By switching to the Offline profile, you can use your 
phone’s non-network services in areas where 
wireless devices are prohibited, such as aeroplane 
and hospitals.

To switch to the Offline profile, press the Confirm key 
→ Settings → Phone profiles → Offline.

Follow all posted warnings and directions from 
official personnel when in areas where wireless 
devices are prohibited.
using basic
functions

 Learn how to perform basic operations and use the
main features of your mobile phone.



Switch to or from the Silent profile
In Idle mode, press and hold [ ] to silence or 
unsilence your phone.

Change your ringtone
1. In Idle mode, press the Confirm key → Settings 

→ Phone profiles.

2. Scroll to the profile you are using.

3. Press <Options> → Edit → Voice call ringtone 
or Video call ringtone.

4. Scroll left or right to a memory location 
(if necessary).

5. Press <Options> → Select.
To switch to another profile, select it from the list.
22

using basic functions

Access menus
To access your phone’s menus,

1. Press the Confirm key to access Menu mode.

2. Use the navigation key to scroll to a menu or 
option.

3. Press <Select>, <Confirm>, or the Confirm key 
to confirm the highlighted option.

4. Press <Back> to move up one level; Press [ ] 
to return to Idle mode.

Customise your phone
Get more from your phone by customising it to 
match your preferences.

Adjust the volume of the key tones
In Idle mode, press [ / ] to adjust the key tone 
volume.
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using basic functions
2. Customise the theme as desired by following the 

screen.

3. When you are finished, enter a name for the 
theme and press <Save>.

4. Press <Yes> to apply the theme.

After you have created a theme,

1. In Idle mode, press the Confirm key → Settings 
→ Display and light settings → My theme → 
Select theme.

2. Select a theme and press <Save>.

3. Press <Yes> to apply the theme.

If you select the same colour for the entire 
theme, you may not be able to recognise the 
display.
Select a wallpaper (Idle mode)
1. In Idle mode, press the Confirm key → Settings 

→ Display and light settings → Homescreen.

2. Scroll left or right to Image and press the 
Confirm key.

3. Select an image category → an image.

4. Press <Select>.

Select a theme for the display (Idle 
mode)
To create a theme,

1. In Idle mode, press the Confirm key → Settings 
→ Display and light settings → My theme → 
Create theme (Easy) or Create theme 
(Expert).



Use basic call functions
Learn to make or answer calls and use basic call 
functions.

Make a call
1. In Idle mode, enter an area code and a phone 

number.

2. Press [ ] to dial the number.
For a video call, press [ ].

3. To end the call, press [ ]. 

Answer a call
1. When a call comes in, press [ ].

For a video call, press [ ] → <Show me>.

2. To end the call, press [ ].
24
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Set menu shortcuts
1. In Idle mode, press the Confirm key → Settings 

→ Phone settings → Shortcuts.

2. Select a key to use as a shortcut.

3. Select a menu to assign to the shortcut key.

Lock your phone
1. In Idle mode, press the Confirm key → Settings 

→ Security → Phone lock.

2. Select On.

3. Enter a new 4- to 8-digit password and press 
<Confirm>.

4. Enter the new password again and press 
<Confirm>. 
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using basic functions
Send and view messages
Learn to send or view text (SMS), multimedia (MMS), 
or email messages.

Send a text or multimedia message
1. In Idle mode, press the Confirm key → 

Messages → Create message → Message.

2. Enter a destination number and scroll down.

3. Enter your message text.  p. 26
For sending as a text message, skip to step 7.
For attaching multimedia, continue with step 4.

4. Press <Options> → Add multimedia and add 
an item.

5. Press <Options> → Advanced → Add subject.

6. Enter a subject.

7. Press the Confirm key to send the message.
Adjust the volume
To adjust the volume during a call, press [ / ].

Use the speakerphone feature
1. During a call, press <Options> → Speaker to 

activate the speaker.

2. To switch back to the earpiece, press 
<Options> → Normal.

Use the headset
By plugging the supplied headset into the 
multifunction jack, you can make and answer calls:

• To redial the last call, press the headset button, 
and then press again and hold.

• To answer a call, press the headset button.
• To end a call, press the headset button.



• Press [ ] to change case or switch to Number 
mode.

• Press and hold [ ] to switch to Symbol mode.
Enter text in one of the following modes:

Mode Function

ABC
Press the appropriate alphanumeric key until 
the character you want appears on the 
display.

T9

1. Press the appropriate alphanumeric keys 
to enter an entire word.

2. When the word displays correctly, press 
[ ] to insert a space. If the correct word 
does not display, press [0] to select an 
alternate word.

Number Press the appropriate alphanumeric key to 
enter a number.

Symbol Press the appropriate alphanumeric key to 
select a symbol.
26
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Send an email
1. In Idle mode, press the Confirm key → 

Messages → Create message → Email.

2. Enter an email address and scroll down.

3. Enter a subject and scroll down.

4. Enter your email text.

5. Press <Options> → Attach multimedia or 
Attach organiser and attach a file (if necessary).

6. Press the Confirm key to send the email.

Enter text
When entering text, you can change the text input 
mode:

• Press and hold [ ] to switch between T9 and 
ABC modes.
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using basic functions
dd and find contacts

earn the basics of using the Phonebook feature.

dd a new contact
. In Idle mode, enter a phone number and press 

<Options>.

. Select Add to Phonebook → a memory location 
(phone or SIM) → New. 

. Select a number type (if necessary).

. Enter contact information.

. Press the Confirm key, or press <Options> → 
Save to add the contact to memory.

ind a contact
. In Idle mode, press the Confirm key → 

Phonebook.

. Enter the first few letters of the name you want to 
find.
View text or multimedia messages
1. In Idle mode, press the Confirm key → 

Messages → Inbox.

2. Select a text or multimedia message.

View an email
1. In Idle mode, press the Confirm key → 

Messages → Email inbox.

2. Press <Options> → Download.

3. Select an email or a header.

4. If you selected a header, press <Options> → 
Retrieve to view the body of the email.

A
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View photos
In Idle mode, press the Confirm key → My files → 
Images → My photos → a photo file.

Capture videos
1. Press and hold [ ] to turn on the camera.

2. Press [1] to switch to Recording mode.

3. Aim the lens at the subject and make any 
adjustments.

4. Press [ ] to start recording.

5. Press [ ] to stop recording. 
The video is saved automatically.

6. Press < > to record another video (step 3).

View videos
In Idle mode, press the Confirm key → My files → 
Videos → My video clips → a video file.
28

using basic functions

3. Select the contact’s name from the search list.

Use basic camera functions
Learn the basics to capture and view photos and 
videos.

Capture photos
1. Press and hold [ ] to turn on the camera.

2. Aim the lens at the subject and make any 
adjustments.

3. Press [ ] to take a photo. 
The photo is saved automatically.

4. Press < > to take another photo (step 2).

Once you have found a contact, you can:
• call the contact by pressing [ ]
• edit the contact information by pressing 

<Options> → Edit
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Listen to music files
Start by transferring files to your phone or memory 
card:

• Download from the wireless web.  p. 30
• Download from a PC with the optional Samsung 

PC Studio.  p. 37
• Receive via Bluetooth.  p. 41
• Copy to your memory card.  p. 37
• Synchronise with Windows Media Player 11. 

 p. 38
After transferring music files to your phone or 
memory card,

1. In Idle mode, press the Confirm key → 
Multimedia → Music player.

2. Select a music category → a music file.
Listen to music
Learn how to listen to music via the music player or 
FM radio.

Listen to the FM radio
1. Plug the supplied headset into the phone’s 

multifunction jack.

2. In Idle mode, press the Confirm key → 
Multimedia → FM radio.

3. Press <Yes> to start automatic tuning.
The radio scans and saves available stations 
automatically. 

4. Press the Confirm key to start the radio.

5. Scroll left or right to a radio station.

6. To turn off the FM radio, press the Confirm key.

The first time you access the FM radio, you 
will be prompted to start automatic tuning.



Browse the web
Learn to access and bookmark your favourite web 
pages.

Browse web pages
1. In Idle mode, press the Confirm key → 

Applications → Browser → Home to launch 
your service provider’s homepage.

2. Navigate web pages using the following keys:

Key Function

Navigation Scroll up or down on a web page

Confirm Select an item

<Back> Return to the previous page

<Options> Access a list of browser options
30
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3. Control playback using the following keys:

Key Function

Confirm Pause or resume playback

Volume Adjust the volume up or down

Navigation

• Left: Restart playback; Skip 
backward (press within 3 
seconds); Scan backward in a file 
(press and hold)

• Right: Skip forward; Scan forward 
in a file (press and hold)

• Up: Open the playlist
• Down: Stop playback
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Bookmark your favourite web pages
1. In Idle mode, press the Confirm key → 

Applications → Browser → Bookmarks.

2. Press <Options> → Add bookmark.

3. Enter a page title and a web address (URL).

4. Press <Save>.
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Use advanced call functions
Learn about your phone’s additional calling 
capabilities. 

View and dial missed calls
Your phone will display calls you have missed on the 
display. To dial the number of a missed call,

1. Press <View>.

2. Scroll to the missed call you want to dial.

3. Press [ ] to dial.

Call a recently dialled number
1. In Idle mode, press [ ] to display a list of 

recent numbers.

2. Scroll to the number you want and press [ ] to 
dial.
using advanced
functions

 Learn how to perform advanced operations and use
additional features of your mobile phone.
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nswer a second call

 your network supports this function, you can 
nswer a second incoming call:

. Press [ ] to answer the second call.
The first call is automatically placed on hold.

. Press <Swap> to switch between the calls.

ake a multiparty call (conference call)
. Call the first party you want to add to the 

multiparty call.

. While connected to the first party, call the 
second party.
The first party is automatically placed on hold.

. When connected to the second party, press 
<Options> → Conference call.
Hold a call or retrieve a held call
Press <Hold> to place a call on hold or press 
<Retrieve> to retrieve a held call.

Dial a second call
If your network supports this function, you can dial 
another number during a call:

1. Press <Hold> to place the first call on hold.

2. Enter the second number to dial and press [ ].

3. Press <Swap> to switch between the two calls.

4. To end the call on hold, press <Options> → End 
call → Held Call.

5. To end the current call, press [ ].

A
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Use advanced Phonebook functions
Learn to create namecards, set speed dial numbers, 
and create groups of contacts.

Create a namecard
1. In Idle mode, press the Confirm key → 

Phonebook.

2. Press <Options> → My namecard.

3. Enter your personal details.

4. Press the Confirm key or press <Options> → 
Save.

You can send your namecard by attaching it to 
a message or email or transferring it via the 
Bluetooth wireless feature.
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4. Repeat steps 2 and 3 to add more parties 
(if necessary).

5. To end the multiparty call, press [ ].

Call an international number
1. In Idle mode, press and hold [0] to insert the + 

character.

2. Enter the complete number you want to dial 
(country code, area code, and phone number), 
and then press [ ] to dial. 

Call a contact from Phonebook
You can call numbers directly from Phonebook using 
stored contacts.  p. 27

1. In Idle mode, press the Confirm key → 
Phonebook.

2. Scroll to the number you want to dial and press 
[ ] to dial.
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Create a group of contacts
By creating groups of contacts, you can assign 
ringtones and caller ID photos to each group or send 
messages and emails to an entire group. Start by 
creating a group:

1. In Idle mode, press the Confirm key → 
Phonebook.

2. Scroll left or right to Groups.

3. Press <Options> → Create group → a memory 
location (if necessary).

4. Enter a group name and press <Save>.

5. Press <Options> → Group settings.

6. To set the caller ID image, press the Confirm key 
→ an image category → an image.
Set speed dial numbers
1. In Idle mode, press the Confirm key → 

Phonebook.

2. Scroll to a contact to assign.

3. Press <Options> → Assign speed dial.

4. Scroll to a number you want to set (2-9) and 
press <Select>.
The contact is saved to the speed dial number.

You can now call this contact from Idle mode 
by pressing and holding the assigned speed 
dial number.



Create a multimedia template
1. In Idle mode, press the Confirm key → 

Messages → Templates → Multimedia 
templates.

2. Press <Create> to open a new template 
window.

3. Create a multimedia message, with a subject 
and desired attachments, to use as your 
template.  p. 25

4. Press the Confirm key to save the template.

Insert text templates in new messages
1. To start a new message, press the Confirm key 

→ Messages → Create message → a message 
type.

2. Scroll down to the text field, and press 
<Options> → Insert → Text template → a 
template.
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7. To set a group ringtone, scroll down and press 
the Confirm key → a ringtone category → a 
ringtone.

8. Press <Options> → Save.

Use advanced messaging functions
Learn to create templates and use templates to 
create new messages.

Create a text template
1. In Idle mode, press the Confirm key → 

Messages → Templates → Text templates.

2. Press <Create> to open a new template 
window.

3. Enter your text and press the Confirm key to save 
the template.
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2. Press [ ] to return to Idle mode.

3. Using an optional PC data cable, connect the 
multifunction jack on your phone to a PC.

4. Run Samsung PC Studio and copy files from the 
PC to the phone.
Refer to the Samsung PC Studio help for more 
information.

Copy music file to a memory card
1. Insert a memory card.

2. In Idle mode, press the Confirm key → Settings 
→ Phone settings → PC connections → Mass 
storage.

3. Press [ ] to return to Idle mode.

4. Using an optional PC data cable, connect the 
multifunction jack on your phone to a PC.
When connected, a pop-up window will appear 
on the PC.
Create a message from a multimedia 
template
1. In Idle mode, press the Confirm key → 

Messages → Templates → Multimedia 
templates.

2. Scroll to the template you want and press 
<Options> → Send.
Your template opens as a new multimedia 
message.

Use advanced music functions
Learn to prepare music files, create playlists, and 
store radio stations.

Copy music files via Samsung PC Studio
1. In Idle mode, press the Confirm key → Settings 

→ Phone settings → PC connections → 
Samsung PC studio.



5. Edit or enter your phone’s name in the pop-up 
window (if necessary), and then click Finish.

6. Select and drag the music files you want to the 
sync list. 

7. Click Start Sync.

Create a playlist
1. In Idle mode, press the Confirm key → 

Multimedia → Music player → Playlists.

2. Press <Options> → Create playlist.

3. Enter a title for your new playlist and press 
<Save>.

4. Select the new playlist.

5. Press <Options> → Add → Tracks.

6. Select the files you want to include and press 
<OK>.
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5. Select Open folder to view files in the pop-up 
window on the PC.

6. Copy files from the PC to the memory card. 

Synchronise your phone with Windows 
Media Player
1. In Idle mode, press the Confirm key → Settings 

→ Phone settings → PC connections → 
Media player.

2. Press [ ] to return to Idle mode.

3. Using an optional PC data cable, connect the 
multifunction jack on your phone to a PC with 
Windows Media Player installed.
When connected, a pop-up window will appear 
on the PC.

4. Select Sync digital media files to this device in 
the pop-up window on the PC.
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Store radio stations automatically
1. Plug the supplied headset into the phone’s 

multifunction jack.

2. In Idle mode, press the Confirm key → 
Multimedia → FM radio.

3. Press the Confirm key to start the radio.

4. Press <Options> → Self-tuning.

5. Press <Yes> to confirm.
The radio scans and saves available stations 
automatically.
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Use the Bluetooth wireless feature
Learn about your phone’s ability to connect to other 
wireless devices for exchanging data and using 
hands-free features.

Turn on the Bluetooth wireless feature
1. In Idle mode, press the Confirm key → 

Applications → Bluetooth.

2. Press <Options> → Settings.

3. Scroll down to Activation.

4. Scroll left or right to On.

5. To allow other devices to locate your phone, 
scroll down to My phone’s visibility and scroll 
left or right to On.

6. Press <Save>.
using tools and
applications

 Learn how to work with your mobile phone’s tools
and additional applications.
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Send data using the Bluetooth wireless 
feature
1. Select the file or item from one of your phone’s 

applications that you want to send.

2. Press <Options> → Send namecard via, Send 
via, or Send URL via → Bluetooth (when 
sending contact data, specify which data to 
send).

Receive data using the Bluetooth 
wireless feature
1. Enter the PIN for the Bluetooth wireless feature 

and press <OK> (if necessary).

2. Press <Yes> to confirm that you are willing to 
receive data from the device (if necessary).
Find and pair with other Bluetooth-
enabled devices
1. In Idle mode, press the Confirm key → 

Applications → Bluetooth → Search for new 
devices.

2. Scroll to a device and press <Select>.

3. Enter a PIN for the Bluetooth wireless feature or 
the other device’s Bluetooth PIN, if it has one, 
and press <OK>.
When the owner of the other device enters the 
same code or accepts the connection, pairing is 
complete.



3. Select a Bluetooth-enabled printer and pair with 
the printer.  p. 41

4. Set print options and press <Print>.

Activate and send an SOS message
When you have an emergency, you can send an 
SOS message asking for help.

1. In Idle mode, press the Confirm key → 
Messages → SOS messages → Sending 
options.

2. Scroll left or right to On.

3. Scroll down and press the Confirm key to open 
the recipient list.

4. Press <Options> → Phonebook to open your 
contact list.

5. Scroll to a contact and press the Confirm key.
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Print images
Learn to print your image with an optional PC data 
cable or the Bluetooth wireless feature.

To print an image using an optional PC data cable,

1. Connect the multifunction jack on your phone to 
a compatible printer.

2. In Idle mode, press the Confirm key → My files 
→ Images → an image.

3. Press <Options> → Print via → USB.

4. Set print options and press <Print>.
To print an image using the Bluetooth wireless 
feature,

1. In Idle mode, press the Confirm key → My files 
→ Images → an image.

2. Press <Options> → Print via → Bluetooth.
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o activate the mobile tracker,

. In Idle mode, press the Confirm key → Settings 
→ Security → Mobile tracker.

. Enter your password and press <Confirm>.

. Scroll left or right to On.

. Scroll down and press the Confirm key to open 
the recipient list.

. Press <Options> → Phonebook to open your 
contact list.

. Scroll to a contact and press the Confirm key.

. Select a number.

. Press <Options> → OK to save the recipients.

. Scroll down and enter the sender’s name.

0.Press <Options> → Save → <Accept>.
6. When you are finished selecting contacts, press 
<Done> to return to the recipient list.

7. Press <Options> → OK to save the recipients.

8. Scroll down and set the number of times to 
repeat the SOS message.

9. Press <Save> → <Yes>.
To send an SOS message, the keys must be locked. 
With the keys locked, press [ / ] four times.

Activate the mobile tracker
When someone inserts a new SIM or USIM card in 
your phone, the mobile tracker feature will 
automatically send the contact number to two 
recipients to help you locate and recover your 
phone.
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Once you send an SOS message, all phone 
functions will be suspended until you press 
[ ].



3. Control the playback using the following keys:

Use Java-powered games and 
applications
Learn to use games and applications powered by 
award-winning Java technology.

Play games
1. In Idle mode, press the Confirm key → My files 

or Entertainment → Games and more.

Key Function

Confirm Pause or resume playback

Volume Adjust the volume up or down

Navigation
• Left: Scan backward in a file
• Right: Scan forward in a file
• Down: Stop playback
44

using tools and applications

Record and play voice memos
Learn to operate your phone’s voice recorder.

Record a voice memo
1. In Idle mode, press the Confirm key → 

Multimedia → Voice recorder.

2. Press the Confirm key to start recording.

3. Speak your memo into the microphone.

4. When you are finished speaking, press the 
navigation key down.

Play a voice memo
1. From the voice recorder screen, press 

<Options> → My voice clips.

2. Select a file.
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reate feeds

. In Idle mode, press the Confirm key → 
Applications → RSS reader.

. Press <Options> → Add.

. Enter the address of an RSS feed and press 
<OK>.

. To add more feeds, repeat steps 2-3 above.

ead RSS feeds
. In Idle mode, press the Confirm key → 

Applications → RSS reader.

. Press <Options> → Update → Selected or All 
to get the latest contents. 

. Select a feed → an updated post.
2. Select a game from the list and follow the 
onscreen instructions.

Launch applications
1. In Idle mode, press the Confirm key → My files 

or Entertainment → Games and more → an 
application.

2. Press <Options> to access a list of various 
options and settings for your application. 

Use the RSS reader
Learn to use the RSS reader to get the latest news 
and information from your favourite websites.
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Available games may vary, depending on your 
service provider or region. Game controls and 
options may vary.



Create and view world clocks
Learn to view the time in another country or city and 
set world clocks to appear on your display.

Create a world clock
1. In Idle mode, press the Confirm key → 

Applications → World clock.

2. Press <Options> → Add.

3. Scroll left or right to a time zone.

4. To set daylight saving time, scroll down and 
press the Confirm key.

5. Press <OK> to save your world clock.

6. To add more world clocks, repeat steps 2-5 
above.
46

using tools and applications

Download multimedia
1. In Idle mode, press the Confirm key → 

Applications → RSS reader.

2. Scroll to a feed and press <Options> → Open.

3. Scroll to a post containing multimedia.

4. Press <Options> → Media → Download.

Customise RSS reader settings
1. In Idle mode, press the Confirm key → 

Applications → RSS reader.

2. Press <Options> → Settings.

3. Customise the settings as desired.
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Set and use alarms
Learn to set and control alarms for important events.

Set a new alarm
1. In Idle mode, press the Confirm key → Alarms.

2. Scroll to an empty alarm location and press the 
Confirm key.

3. Set alarm details.

4. Press <Options> → Save.
The auto power-up feature sets the phone to 
automatically turn on and sound the alarm at 
the designated time if the phone is turned off.
Add a world clock to your display
In Dual Clock Display mode, you can view clocks 
with two different time zones on your display.

After you have saved world clocks,

1. In Idle mode, press the Confirm key → 
Applications → World clock.

2. Scroll to the world clock you want to add and 
press <Options> → Set as second clock.

3. Press <Options> → Display settings.

4. Scroll left or right to Dual.

5. Scroll down, and then scroll left or right to a dual 
clock style.

6. Press <Save>.



Use the pedometer
1. In Idle mode, press the Confirm key → 

Applications → Pedometer.

2. Enter user information and press <Save>.

3. Press the Confirm key to start the pedometer.

4. Press the Confirm key to stop the pedometer.

Use the compass
Learn to read the directions and altitudes.

1. In Idle mode, press the Confirm key → 
Applications → Compass.

2. If you use the compass for the first time, calibrate 
it by turning your phone over as shown on the 
screen.

3. To recalibrate the compass, press <Calibrate>.
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Stop an alarm
When the alarm sounds,

• Press the Confirm key to stop an alarm without 
snooze.

• Press <OK> or the Confirm key to stop an alarm 
with snooze, or press <Snooze> or any key to 
silence the alarm for the snooze period.

Deactivate an alarm
1. In Idle mode, press the Confirm key → Alarms.

2. Scroll to the alarm you want to deactivate and 
press the Confirm key.

3. Scroll down (if necessary).

4. Scroll left or right to Off.

5. Press the Confirm key.
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Convert currencies or 
measurements
1. In Idle mode, press the Confirm key → 

Applications → Convertor → a conversion type.

2. Enter the currencies or measurements and units 
in the appropriate fields.

Set a countdown timer
1. In Idle mode, press the Confirm key → 

Applications → Timer.

2. Press <Set>.

3. Enter hours or minutes to count down and press 
<OK>.

s 
 
.

n 
To use the compass, hold the phone flat in your 
palm, parallel to the ground and read the direction

Use the calculator
1. In Idle mode, press the Confirm key → 

Applications → Calculator.

2. Use the keys that correspond to the calculato
display to perform basic mathematical 
operations.

• Remove any metal jewellery and avoid 
coming too close to metal objects or place
that affect the compass magnet. This may
affect the accuracy of the direction reading

• The altitude measured at the same locatio
may vary due to air pressure.



Create a new task
1. In Idle mode, press the Confirm key → 

Applications → Task.

2. Press <Options> → Create.

3. Enter the details of the task.

4. Press <Options> → Save.

Create a text memo
1. In Idle mode, press the Confirm key → 

Applications → Memo.

2. Press <Options> → Create.

3. Enter your memo text and press the Confirm key.
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4. Press the Confirm key to begin or pause the 
countdown.

5. When the timer expires, press <OK> to stop the 
alert.

Use the stopwatch
1. In Idle mode, press the Confirm key → 

Applications → Stopwatch.

2. Press the Confirm key to begin and record lap 
times.

3. When you are finished, press <Stop>.

4. Press <Reset> to clear recorded times.
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Manage your calendar
Learn to change the calendar view and create 
events.

Change the calendar view
1. In Idle mode, press the Confirm key → Calendar.

2. Press <Options> → View by → Day or Week.

Create an event
1. In Idle mode, press the Confirm key → Calendar.

2. Press <Options> → Create → an event type.

3. Enter the details of the event as required and 
press the Confirm key.



Specific Absorption Rate (SAR). The SAR is a measure 
of the rate of absorption of RF energy by the human 
body expressed in units of watts per kilogram (W/kg). 
The FCC requires wireless phones to comply with a 
safety limit of 1.6 watts per kilogram (1.6 W/kg). The 
FCC exposure limit incorporates a substantial margin of 
safety to give additional protection to the public and to 
account for any variations in measurements.

SAR tests are conducted using standard operating 
positions accepted by the FCC with the phone 
transmitting at its highest certified power level in all 
tested frequency bands. Although the SAR is 
determined at the highest certified power level, the 
actual SAR level of the phone while operating can be 
well below the maximum value. This is because the 
phone is designed to operate at multiple power levels so 
as to use only the power required to reach the network. 
In general, the closer you are to a wireless base station 
antenna, the lower the power output.

Before a new model phone is available for sale to the 
public, it must be tested and certified to the FCC that it 
does not exceed the exposure limit established by the 
Health and safety information
Exposure to Radio Frequency (RF) Signals

Certification Information (SAR)
Your wireless phone is a radio transmitter and receiver. 
It is designed and manufactured not to exceed the 
exposure limits for radio frequency (RF) energy set by 
the Federal Communications Commission (FCC) of the 
U.S. government. These FCC exposure limits are 
derived from the recommendations of two expert 
organizations, the National Counsel on Radiation 
Protection and Measurement (NCRP) and the Institute 
of Electrical and Electronics Engineers (IEEE). In both 
cases, the recommendations were developed by 
scientific and engineering experts drawn from industry, 
government, and academia after extensive reviews of 
the scientific literature related to the biological effects 
of RF energy.

The exposure limit set by the FCC for wireless mobile 
phones employs a unit of measurement known as the 



SAR for a particular phone. Additional product specific 
SAR information can also be obtained at www.fcc.gov/
cgb/sar.

Consumer Information on Wireless Phones

 
The U.S. Food and Drug Administration (FDA) has 
published a series of Questions and Answers for 
consumers relating to radio frequency (RF) exposure 
from wireless phones. The FDA publication includes the 
following information:

What kinds of phones are the subject of this 
update?
The term wireless phone refers here to hand-held 
wireless phones with built-in antennas, often called 
“cell,” “mobile,” or “PCS” phones. These types of 
wireless phones can expose the user to measurable 
radio frequency energy (RF) because of the short 
distance between the phone and the user's head. These 
RF exposures are limited by Federal Communications 
Commission safety guidelines that were developed with 
the advice of FDA and other federal health and safety 
agencies. When the phone is located at greater 
53FCC. Tests for each model phone are performed in 
positions and locations (e.g. at the ear and worn on the 
body) as required by the FCC.  

The highest SAR values for this model phone as 
reported to the FCC are: 
 
GSM850 Head: 0.807 W/Kg, Body-worn: 1.220 W/Kg. 
GSM1900 Head: 0.550 W/Kg, Body-worn: 0.490 W/Kg. 
For body worn operation, this model phone has been 
tested and meets the FCC RF exposure guidelines 
whenused with a Samsung accessory designated for 
this product or when used with an accessory that 
contains no metal and that positions the handset a 
minimum of 1.5 cm from the body. 

Non-compliance with the above restrictions may result 
in violation of FCC RF exposure guidelines.

SAR information on this and other model phones can be 
viewed on-line at www.fcc.gov/oet/fccid. This site uses 
the phone FCC ID number, A3LSWDB2700 Sometimes it 
may be necessary to remove the battery pack to find 
the number. Once you have the FCC ID number for a 
particular phone, follow the instructions on the website 
and it should provide values for typical or maximum 
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me cases, other researchers have had difficulty in 
producing those studies, or in determining the 
asons for inconsistent results.

hat is FDA's role concerning the safety of 
ireless phones?
nder the law, FDA does not review the safety of 
diation-emitting consumer products such as wireless 

hones before they can be sold, as it does with new 
rugs or medical devices. However, the agency has 
uthority to take action if wireless phones are shown to 
mit radio frequency energy (RF) at a level that is 
azardous to the user. In such a case, FDA could 
quire the manufacturers of wireless phones to notify 

sers of the health hazard and to repair, replace or 
call the phones so that the hazard no longer exists.

lthough the existing scientific data do not justify FDA 
gulatory actions, FDA has urged the wireless phone 
dustry to take a number of steps, including the 
llowing:

“Support needed research into possible biological 
effects of RF of the type emitted by wireless phones;
distances from the user, the exposure to RF is 
drastically lower because a person's RF exposure 
decreases rapidly with increasing distance from the 
source. The so-called “cordless phones,” which have a 
base unit connected to the telephone wiring in a house, 
typically operate at far lower power levels, and thus 
produce RF exposures well within the FCC's compliance 
limits.

Do wireless phones pose a health hazard?
The available scientific evidence does not show that any 
health problems are associated with using wireless 
phones. There is no proof, however, that wireless 
phones are absolutely safe. Wireless phones emit low 
levels of radio frequency energy (RF) in the microwave 
range while being used. They also emit very low levels 
of RF when in the stand-by mode. Whereas high levels 
of RF can produce health effects (by heating tissue), 
exposure to low level RF that does not produce heating 
effects causes no known adverse health effects. Many 
studies of low level RF exposures have not found any 
biological effects. Some studies have suggested that 
some biological effects may occur, but such findings 
have not been confirmed by additional research. In 
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FDA shares regulatory responsibilities for wireless 
phones with the Federal Communications Commission 
(FCC). All phones that are sold in the United States 
must comply with FCC safety guidelines that limit RF 
exposure. FCC relies on FDA and other health agencies 
for safety questions about wireless phones.

FCC also regulates the base stations that the wireless 
phone networks rely upon. While these base stations 
operate at higher power than do the wireless phones 
themselves, the RF exposures that people get from 
these base stations are typically thousands of times 
lower than those they can get from wireless phones. 
Base stations are thus not the primary subject of the 
safety questions discussed in this document.

What are the results of the research done 
already?
The research done thus far has produced conflicting 
results, and many studies have suffered from flaws in 
their research methods. Animal experiments 
investigating the effects of radio frequency energy (RF) 
exposures characteristic of wireless phones have 
• “Design wireless phones in a way that minimizes 
any RF exposure to the user that is not necessary 
for device function; and

• “Cooperate in providing users of wireless phones 
with the best possible information on possible 
effects of wireless phone use on human health.

FDA belongs to an interagency working group of the 
federal agencies that have responsibility for different 
aspects of RF safety to ensure coordinated efforts at the 
federal level. The following agencies belong to this 
working group:

• “National Institute for Occupational Safety and 
Health

• “Environmental Protection Agency

• “Federal Communications Commission

• “Occupational Safety and Health Administration

• “National Telecommunications and Information 
Administration

The National Institutes of Health participates in some 
interagency working group activities, as well.
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about long-term exposures, since the average period of 
phone use in these studies was around three years.

What research is needed to decide whether RF 
exposure from wireless phones poses a health 
risk?
A combination of laboratory studies and epidemiological 
studies of people actually using wireless phones would 
provide some of the data that are needed. Lifetime 
animal exposure studies could be completed in a few 
years. However, very large numbers of animals would 
be needed to provide reliable proof of a cancer 
promoting effect if one exists. Epidemiological studies 
can provide data that is directly applicable to human 
populations, but ten or more years' follow-up may be 
needed to provide answers about some health effects, 
such as cancer. This is because the interval between the 
time of exposure to a cancer-causing agent and the 
time tumors develop - if they do - may be many, many 
years. The interpretation of epidemiological studies is 
hampered by difficulties in measuring actual RF 
exposure during day-to-day use of wireless phones. 
Many factors affect this measurement, such as the 
yielded conflicting results that often cannot be repeated 
in other laboratories. A few animal studies, however, 
have suggested that low levels of RF could accelerate 
the development of cancer in laboratory animals. 
However, many of the studies that showed increased 
tumor development used animals that had been 
genetically engineered or treated with cancer-causing 
chemicals so as to be pre-disposed to develop cancer in 
absence of RF exposure. Other studies exposed the 
animals to RF for up to 22 hours per day. These 
conditions are not similar to the conditions under which 
people use wireless phones, so we don't know with 
certainty what the results of such studies mean for 
human health.

Three large epidemiology studies have been published 
since December 2000. Between them, the studies 
investigated any possible association between the use 
of wireless phones and primary brain cancer, glioma, 
meningioma, or acoustic neuroma, tumors of the brain 
or salivary gland, leukemia, or other cancers. None of 
the studies demonstrated the existence of any harmful 
health effects from wireless phones RF exposures. 
However, none of the studies can answer questions 



oversight, obtaining input from experts in government, 
industry, and academic organizations. CTIA-funded 
research is conducted through contracts to independent 
investigators. The initial research will include both 
laboratory studies and studies of wireless phone users. 
The CRADA will also include a broad assessment of 
additional research needs in the context of the latest 
research developments around the world.

What steps can I take to reduce my exposure 
to radio frequency energy from my wireless 
phone?
If there is a risk from these products - and at this point 
we do not know that there is - it is probably very small. 
But if you are concerned about avoiding even potential 
risks, you can take a few simple steps to minimize your 
exposure to radio frequency energy (RF). Since time is 
a key factor in how much exposure a person receives, 
reducing the amount of time spent using a wireless 
phone will reduce RF exposure.

• “If you must conduct extended conversations by 
wireless phone every day, you could place more 
distance between your body and the source of the 
angle at which the phone is held, or which model of 
phone is used.

What is FDA doing to find out more about the 
possible health effects of wireless phone RF?
FDA is working with the U.S. National Toxicology 
Program and with groups of investigators around the 
world to ensure that high priority animal studies are 
conducted to address important questions about the 
effects of exposure to radio frequency energy (RF).

FDA has been a leading participant in the World Health 
Organization international Electromagnetic Fields (EMF) 
Project since its inception in 1996. An influential result 
of this work has been the development of a detailed 
agenda of research needs that has driven the 
establishment of new research programs around the 
world. The Project has also helped develop a series of 
public information documents on EMF issues.

FDA and Cellular Telecommunications & Internet 
Association (CTIA) have a formal Cooperative Research 
and Development Agreement (CRADA) to do research 
on wireless phone safety. FDA provides the scientific 



Health and safety information
wireless phones at all. For example, the government in 
the United Kingdom distributed leaflets containing such 
a recommendation in December 2000. They noted that 
no evidence exists that using a wireless phone causes 
brain tumors or other ill effects. Their recommendation 
to limit wireless phone use by children was strictly 
precautionary; it was not based on scientific evidence 
that any health hazard exists. 

Do hands-free kits for wireless phones reduce 
risks from exposure to RF emissions?
Since there are no known risks from exposure to RF 
emissions from wireless phones, there is no reason to 
believe that hands-free kits reduce risks. Hands-free 
kits can be used with wireless phones for convenience 
and comfort. These systems reduce the absorption of 
RF energy in the head because the phone, which is the 
source of the RF emissions, will not be placed against 
the head. On the other hand, if the phone is mounted 
against the waist or other part of the body during use, 
then that part of the body will absorb more RF energy. 
Wireless phones marketed in the U.S. are required to 
meet safety requirements regardless of whether they 
RF, since the exposure level drops off dramatically 
with distance. For example, you could use a headset 
and carry the wireless phone away from your body 
or use a wireless phone connected to a remote 
antenna.

Again, the scientific data do not demonstrate that 
wireless phones are harmful. But if you are concerned 
about the RF exposure from these products, you can 
use measures like those described above to reduce your 
RF exposure from wireless phone use.

What about children using wireless phones?
The scientific evidence does not show a danger to users 
of wireless phones, including children and teenagers. If 
you want to take steps to lower exposure to radio 
frequency energy (RF), the measures described above 
would apply to children and teenagers using wireless 
phones. Reducing the time of wireless phone use and 
increasing the distance between the user and the RF 
source will reduce RF exposure.

Some groups sponsored by other national governments 
have advised that children be discouraged from using 



FTC, these defendants lacked a reasonable basis to 
substantiate their claim.

What about wireless phone interference with 
medical equipment?
Radio frequency energy (RF) from wireless phones can 
interact with some electronic devices. For this reason, 
FDA helped develop a detailed test method to measure 
electromagnetic interference (EMI) of implanted cardiac 
pacemakers and defibrillators from wireless telephones. 
This test method is now part of a standard sponsored 
by the Association for the Advancement of Medical 
instrumentation (AAMI). The final draft, a joint effort by 
FDA, medical device manufacturers, and many other 
groups, was completed in late 2000. This standard will 
allow manufacturers to ensure that cardiac pacemakers 
and defibrillators are safe from wireless phone EMI. FDA 
has tested wireless phones and helped develop a 
voluntary standard sponsored by the Institute of 
Electrical and Electronic Engineers (IEEE). This 
standard specifies test methods and performance 
requirements for hearing aids and wireless phones so 
that no interference occurs when a person uses a 
are used against the head or against the body. Either 
configuration should result in compliance with the 
safety limit.

Do wireless phone accessories that claim to 
shield the head from RF radiation work?
Since there are no known risks from exposure to RF 
emissions from wireless phones, there is no reason to 
believe that accessories that claim to shield the head 
from those emissions reduce risks. Some products that 
claim to shield the user from RF absorption use special 
phone cases, while others involve nothing more than a 
metallic accessory attached to the phone. Studies have 
shown that these products generally do not work as 
advertised. Unlike “hand-free” kits, these so-called 
“shields” may interfere with proper operation of the 
phone. The phone may be forced to boost its power to 
compensate, leading to an increase in RF absorption. In 
February 2002, the Federal trade Commission (FTC) 
charged two companies that sold devices that claimed 
to protect wireless phone users from radiation with 
making false and unsubstantiated claims. According to 



Health and safety information
• National institute for Occupational Safety and Health 

(NIOSH):

• http://www.cdc.gov/niosh/emfpg.html 

• World health Organization (WHO):

• http://www.who.int/peh-emf/

• International Commission on Non-Ionizing Radiation 
Protection:

• http://www.icnirp.de

• National Radiation Protection Board (UK):

• http://www.nrpb.org.uk

• Updated 4/3/2002: US food and Drug 
Administration

• http://www.fda.gov/cellphones
compatible phone and a compatible hearing aid at the 
same time. This standard was approved by the IEEE in 
2000.

FDA continues to monitor the use of wireless phones for 
possible interactions with other medical devices. Should 
harmful interference be found to occur, FDA will conduct 
testing to assess the interference and work to resolve 
the problem.

• Additional information on the safety of RF exposures 
from various sources can be obtained from the 
following organizations:

• FCC RF Safety Program:

• http://www.fcc.gov/oet/rfsafety/

• Environmental Protection Agency (EPA):

• http://www.epa.gov/radiation/

• Occupational Safety and Health Administration's 
(OSHA): 

• http://www.osha.gov/SLTC/
radiofrequencyradiation/index.html



incoming call at an inconvenient time, let your voice 
mail answer it for you.

4. Let the person you are speaking with know you are 
driving; if necessary, suspend the call in heavy 
traffic or hazardous weather conditions. Rain, sleet, 
snow, ice and even heavy traffic can be hazardous.

5. Do not take notes or look up phone numbers while 
driving. Jotting down a “to do” list or flipping 
through your address book takes attention away 
from your primary responsibility, driving safely.

6. Dial sensibly and assess the traffic; if possible, place 
calls when you are not moving or before pulling into 
traffic. Try to plan calls when your car will be 
stationary. If you need to make a call while moving, 
dial only a few numbers, check the road and your 
mirrors, then continue.

7. Do not engage in stressful or emotional 
conversations that may be distracting. Make people 
you are talking with aware you are driving and 
suspend conversations that have the potential to 
divert your attention from the road.
Road Safety

Your wireless phone gives you the powerful ability to 
communicate by voice, almost anywhere, anytime. But 
an important responsibility accompanies the benefits of 
wireless phones, one that every user must uphold.

When driving a car, driving is your first responsibility. 
When using your wireless phone behind the wheel of a 
car, practice good common sense and remember the 
following tips:

1. Get to know your wireless phone and its features, 
such as speed dial and redial. If available, these 
features help you to place your call without taking 
your attention off the road.

2. When available, use a hands-free device. If possible, 
add an additional layer of convenience and safety to 
your wireless phone with one of the many hands 
free accessories available today.

3. Position your wireless phone within easy reach. Be 
able to access your wireless phone without 
removing your eyes from the road. If you get an 
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“The wireless industry reminds you to use 
your phone safely when driving.”
For more information, please call 1-888-901-SAFE, or 
visit our web-site www.wow-com.com

Provided by the Cellular Telecommunications & Internet 
Association

Operating Environment

Remember to follow any special regulations in force in 
any area and always switch your phone off whenever it 
is forbidden to use it, or when it may cause interference 
or danger. When connecting the phone or any accessory 
to another device, read its user's guide for detailed 
safety instructions. Do not connect incompatible 
products.

As with other mobile radio transmitting equipment, 
users are advised that for the satisfactory operation of 
the equipment and for the safety of personnel, it is 
recommended that the equipment should only be used 
in the normal operating position (held to your ear with 
the antenna pointing over your shoulder).
8. Use your wireless phone to call for help. Dial 9-1-1 
or other local emergency number in the case of fire, 
traffic accident or medical emergencies. Remember, 
it is a free call on your wireless phone!

9. Use your wireless phone to help others in 
emergencies. If you see an auto accident, crime in 
progress or other serious emergency where lives are 
in danger, call 9-1-1 or other local emergency 
number, as you would want others to do for you.

10.Call roadside assistance or a special non-emergency 
wireless assistance number when necessary. If you 
see a broken-down vehicle posing no serious 
hazard, a broken traffic signal, a minor traffic 
accident where no one appears injured, or a vehicle 
you know to be stolen, call roadside assistance or 
other special non-emergency number.



• should use the ear opposite the pacemaker to 
minimize potential interference.

If you have any reason to suspect that interference is 
taking place, switch your phone off immediately.

Hearing Aids
Some digital wireless phones may interfere with some 
hearing aids. In the event of such interference, you 
may wish to consult your hearing aid manufacturer to 
discuss alternatives.

Other Medical Devices
If you use any other personal medical devices, consult 
the manufacturer of your device to determine if it is 
adequately shielded from external RF energy. Your 
physician may be able to assist you in obtaining this 
information. Switch your phone off in health care 
facilities when any regulations posted in these areas 
instruct you to do so. Hospitals or health care facilities 
may be using equipment that could be sensitive to 
external RF energy.
Using Your Phone Near Other Electronic 
Devices

Most modern electronic equipment is shielded from 
radio frequency (RF) signals. However, certain 
electronic equipment may not be shielded against the 
RF signals from your wireless phone. Consult the 
manufacturer to discuss alternatives.

Pacemakers
Pacemaker manufacturers recommend that a minimum 
distance of 15 cm (6 inches) be maintained between a 
wireless phone and a pacemaker to avoid potential 
interference with the pacemaker.

These recommendations are consistent with the 
independent research and recommendations of Wireless 
Technology Research.

Persons with pacemakers:
• should always keep the phone more than 15 cm 

(6 inches) from their pacemaker when the phone is 
switched on.

• should not carry the phone in a breast pocket.



Health and safety information
areas), chemical plants or where blasting operations 
are in progress.

Areas with a potentially explosive atmosphere are often 
but not always clearly marked. They include below deck 
on boats, chemical transfer or storage facilities, vehicles 
using liquefied petroleum gas (such as propane or 
butane), areas where the air contains chemicals or 
particles, such as grain, dust or metal powders, and any 
other area where you would normally be advised to turn 
off your vehicle engine.
Vehicles
RF signals may affect improperly installed or 
inadequately shielded electronic systems in motor 
vehicles. Check with the manufacturer or its 
representative regarding your vehicle. You should also 
consult the manufacturer of any equipment that has 
been added to your vehicle.

Posted Facilities
Switch your phone off in any facility where posted 
notices require you to do so.

Potentially Explosive Environments

Switch your phone off when in any area with a 
potentially explosive atmosphere and obey all signs and 
instructions. Sparks in such areas could cause an 
explosion or fire resulting in bodily injury or even death.

Users are advised to switch the phone off while at a 
refueling point (service station). Users are reminded of 
the need to observe restrictions on the use of radio 
equipment in fuel depots (fuel storage and distribution 



If certain features are in use (call barring, for example), 
you may first need to deactivate those features before 
you can make an emergency call. Consult this 
document and your local cellular service provider.

When making an emergency call, remember to give all 
the necessary information as accurately as possible. 
Remember that your phone may be the only means of 
communication at the scene of an accident; do not cut 
off the call until given permission to do so.

Restricting Children's access to your Phone
Your phone is not a toy. Children should not be allowed 
to play with it because they could hurt themselves and 
others, damage the phone or make calls that increase 
your phone bill.
Emergency Calls

This phone, like any wireless phone, operates using 
radio signals, wireless and landline networks as well as 
user programmed functions, which cannot guarantee 
connection in all conditions. Therefore, you should 
never rely solely on any wireless phone for essential 
communications (medical emergencies, for example).

Remember, to make or receive any calls the phone 
must be switched on and in a service area with 
adequate signal strength. Emergency calls may not be 
possible on all wireless phone networks or when certain 
network services and/or phone features are in use. 
Check with local service providers.

To make an emergency call:

1. If the phone is not on, switch it on.
2. Key in the emergency number for your present 

location (for example. 911 or other official 
emergency number). Emergency numbers vary by 
location

3. Press [ ]  .
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if not installed and used in accordance with the 
instructions, may cause harmful interference to 
radio communications. However, there is no 
guarantee that interference will not occur in a 
particular installation. If this equipment does 
cause harmful interference to radio or television 
reception, which can be determined by turning 
the equipment off and on, the user is 
encouraged to try to correct the interference by 
one or more of the following measures:

-Reorient or relocate the receiving antenna. 

-Increase the separation between the equipment 
and receiver. 

-Connect the equipment into an outlet on a 
circuit different from that to which the receiver 
is connected. 

-Consult the dealer or an experienced radio/TV 
technician for help.
FCC Notice and Cautions

•This device complies with Part 15 of the FCC 
Rules. Operation is  subject to the following 
two conditions: (1) this device may not cause 
harmful interference, and (2) this device must 
accept any interference received, including 
interference that may cause undesired 
operation.

•This equipment has been tested and found 
to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC Rules. 
These limits are designed to provide 
reasonable protection against harmful 
interference in a residential installation. This 
equipment generates, uses and can radiate 
radio frequency energy and,



Other Important Safety Information

• Only qualified personnel should service the phone or 
install the phone in a vehicle. Faulty installation or 
service may be dangerous and may invalidate any 
warranty applicable to the device.

• Check regularly that all wireless phone equipment in 
your vehicle is mounted and operating properly.

• Do not store or carry flammable liquids, gases or 
explosive materials in the same compartment as the 
phone, its parts or accessories.

• For vehicles equipped with an air bag, remember 
that an air bag inflates with great force. Do not 
place objects, including both installed or portable 
wireless equipment in the area over the air bag or in 
the air bag deployment area. If wireless equipment 
is improperly installed and the air bag inflates, 
serious injury could result.

• Switch your phone off before boarding an aircraft. 
The use of wireless phone in aircraft is illegal and 
may be dangerous to the aircraft's operation.
The phone may cause TV or radio interference if used in 
close proximity to receiving equipment. The FCC can 
require you to stop using the phone if such interference 
cannot be eliminated.

Vehicles using liquefied petroleum gas (such as propane 
or butane) must comply with the National Fire 
Protection Standard (NFPA-58). For a copy of this 
standard, contact the National Fire Protection 
Association, One Battery march Park, Quincy, MA 
02269, Attn: Publication Sales Division.

Cautions
Changes or modifications made in the radio phone, not 
expressly approved by Samsung, will void the user’s 
authority to operate the equipment.

Only use approved batteries, antennas and chargers. 
The use of any unauthorized accessories may be 
dangerous and void the phone warranty if said 
accessories cause damage or a defect to the phone.

Although your phone is quite sturdy, it is a complex 
piece of equipment and can be broken. Avoid dropping, 
hitting, bending or sitting on it.
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Anytime the Power Save feature is activated, a 
message displays on the screen. When a signal is 
found, your phone returns to standby mode.

Maintaining Your Phone's Peak Performance
For the best care of your phone, only authorized 
personnel should service your phone and accessories. 
Faulty service may void the warranty.

There are several simple guidelines to operating your 
phone properly and maintaining safe, satisfactory 
service.

• Hold the phone with the antenna raised, fully-
extended and over your shoulder.

• Try not to hold, bend or twist the phone's antenna.

• Don't use the phone if the antenna is damaged.

• Speak directly into the phone's receiver.

• Avoid exposing your phone and accessories to rain 
or liquid spills. If your phone does get wet, 
immediately turn the power off and remove the 
battery. If it is inoperable, call Customer Care for 
service.
• Failure to observe these instructions may lead to the 
suspension or denial of telephone services to the 
offender, or legal action, or both.

Product Performance

Getting the Most Out of Your Signal Reception
The quality of each call you make or receive depends on 
the signal strength in your area. Your phone informs 
you of the current signal strength by displaying a 
number of bars next to the signal strength icon. The 
more bars displayed, the stronger the signal.

If you're inside a building, being near a window may 
give you better reception.

Understanding the Power Save Feature
If your phone is unable to find a signal after 15 minutes 
of searching, a Power Save feature is automatically 
activated. If your phone is active, it periodically 
rechecks service availability or you can check it yourself 
by pressing any key.



Battery Precautions

• Never use any charger or battery that is damaged in 
any way.

• Use the battery only for its intended purpose.

• If you use the phone near the network's base 
station, it uses less power; talk and standby time 
are greatly affected by the signal strength on the 
cellular network and the parameters set by the 
network operator.

• Battery charging time depends on the remaining 
battery charge and the type of battery and charger 
used. The battery can be charged and discharged 
hundreds of times, but it will gradually wear out. 
When the operation time (talk time and standby 
time) is noticeably shorter than normal, it is time to 
buy a new battery.

• If left unused, a fully charged battery will discharge 
itself over time.

• Use only Samsung-approved batteries and recharge 
your battery only with Samsung-approved chargers. 
Availability of Various Features/Ring 
Tones

Many services and features are network dependent and 
may require additional subscription and/or usage 
charges. Not all features are available for purchase or 
use in all areas. Downloadable Ring Tones may be 
available at an additional cost. Other conditions and 
restrictions may apply. See your service provider for 
additional information.

Battery Standby and Talk Time

Standby and talk times will vary depending on phone 
usage patterns and conditions. Battery power 
consumption depends on factors such as network 
configuration, signal strength, operating temperature, 
features selected, frequency of calls, and voice, data, 
and other application usage patterns. 
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terminals may damage the battery or the object 
causing the short-circuiting.

• Dispose of used batteries in accordance with local 
regulations. In some areas, the disposal of batteries 
in household or business trash may be prohibited. 
For safe disposal options for Li-Ion batteries, contact 
your nearest Samsung authorized service center. 
Always recycle. Do not dispose of batteries in a fire.

Care and Maintenance

Your phone is a product of superior design and 
craftsmanship and should be treated with care. The 
suggestions below will help you fulfill any warranty 
obligations and allow you to enjoy this product for many 
years.

• Keep the phone and all its parts and accessories out 
of the reach of small children.

• Keep the phone dry. Precipitation, humidity and 
liquids contain minerals that will corrode electronic 
circuits.
When a charger is not in use, disconnect it from the 
power source. Do not leave the battery connected to 
a charger for more than a week, since overcharging 
may shorten its life.

• Extreme temperatures will affect the charging 
capacity of your battery: it may require cooling or 
warming first.

• Do not leave the battery in hot or cold places, such 
as in a car in summer or winter conditions, as you 
will reduce the capacity and lifetime of the battery. 
Always try to keep the battery at room temperature. 
A phone with a hot or cold battery may temporarily 
not work, even when the battery is fully charged. Li-
ion batteries are particularly affected by 
temperatures below 0 °C (32 °F).

• Do not short-circuit the battery. Accidental short- 
circuiting can occur when a metallic object (coin, clip 
or pen) causes a direct connection between the + 
and - terminals of the battery (metal strips on the 
battery), for example when you carry a spare 
battery in a pocket or bag. Short-circuiting the 



• Do not paint the phone. Paint can clog the device's 
moving parts and prevent proper operation.

• Do not put the phone in or on heating devices, such 
as a microwave oven, a stove or a radiator. The 
phone may explode when overheated.

• When the phone or battery gets wet, the label 
indicating water damage inside the phone changes 
color. In this case, phone repairs are no longer 
guaranteed by the manufacturer's warranty, even if 
the warranty for your phone has not expired. 

• If your phone has a flash or light, do not use it too 
close to the eyes of people or animals. This may 
cause damage to their eyes.

• Use only the supplied or an approved replacement 
antenna. Unauthorized antennas or modified 
accessories may damage the phone and violate 
regulations governing radio devices.

• If the phone, battery, charger or any accessory is 
not working properly, take it to your nearest 
qualified service facility. The personnel there will 
assist you, and if necessary, arrange for service.
• Do not use the phone with a wet hand. Doing so 
may cause an electric shock to you or damage to 
the phone.

• Do not use or store the phone in dusty, dirty areas, 
as its moving parts may be damaged.

• Do not store the phone in hot areas. High 
temperatures can shorten the life of electronic 
devices, damage batteries, and warp or melt certain 
plastics.

• Do not store the phone in cold areas. When the 
phone warms up to its normal operating 
temperature, moisture can form inside the phone, 
which may damage the phone's electronic circuit 
boards.

• Do not drop, knock or shake the phone. Rough 
handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents or 
strong detergents to clean the phone. Wipe it with a 
soft cloth slightly dampened in a mild soap-and-
water solution.



 troubleshooting procedures before contacting a service 

PIN lock

When using the phone for the first 
time or when the PIN requirement is 
enabled, you must enter the PIN 
supplied with the SIM or USIM card. 
You can disable this feature by using 
the PIN lock menu.

PUK lock

Your SIM or USIM card is blocked, 
usually as a result of entering your 
PIN incorrectly several times. You 
must enter the PUK supplied by your 
service provider. 

Message Try this to solve the problem:
a

troub
If you are havin
professional.

While you tu
messages m

Message
Insert SIM 
card

Phone lock
leshooting
g trouble with your mobile phone, try these

rn on your phone, the following 
ay appear:

Try this to solve the problem:
Ensure that the SIM or USIM card is 
installed correctly.

When the phone lock feature is 
enabled, you must enter the 
password you set for the phone.



b

troubleshooting
Another caller cannot reach you.

• Ensure that your phone is turned on.
• Ensure that you have accessed the right cellular 

network.
• Ensure that you have not set call barring for the 

phone number.

Another caller cannot hear you speaking.

• Ensure that you are not covering the built-in 
microphone.

• Ensure that the microphone is close to your 
mouth.

• If using a headset, ensure that it is properly 
connected.
Your phone displays “No service” or “Service 
unavailable.”

• When you are in areas with weak signals or poor 
reception, you may lose reception. Move to 
another area and try again.

• You cannot access some options without a 
subscription. Contact your service provider for 
more details.

You enter a number, but the call is not dialled.

• Ensure that you have pressed the Dial key: [ ].
• Ensure that you have accessed the right cellular 

network.
• Ensure that you have not set call barring for the 

phone number.



The battery does not charge properly or 
sometimes the phone turns itself off.

• The battery terminals may be dirty. Wipe both 
gold-coloured contacts with a clean, soft cloth 
and try charging the battery again.

• If the battery will no longer charge completely, 
dispose of the old battery properly and replace it 
with a new battery.

Your phone is hot to the touch.

When you use several applications at once, your 
phone requires more power and may heat up.

This is normal and should not affect your phone’s 
lifespan or performance.
c

troubleshooting

The phone beeps and the battery icon flashes.

Your battery is low. Recharge or replace the battery to 
continue using the phone.

The audio quality of the call is poor.

• Ensure that you are not blocking the phone’s 
internal antenna.

• When you are in areas with weak signals or poor 
reception, you may lose reception. Move to 
another area and try again.

You select a contact to call, but the call is not 
dialled.

• Ensure that the correct number is stored in the 
contact list.

• Re-enter and save the number, if necessary.
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Declaration of Conformity (R&TTE)

We, Samsung Electronics

declare under our sole responsibility that the product

GSM Mobile Phone : B2700
to which this declaration relates, is in conformity with the following 
standards and/or other normative documents.

SAFETY EN 609501 : 2001+A11:2004

EMC EN 301 48901 V1.5.1 (112004)
EN 301 48907 V1.2.1 (082002)
EN 301 48917 V1.2.1 (082002)
EN 301 48924 V1.2.1 (112002)

SAR EN 50360 : 2001
EN 622091 : 2006

RADIO EN 301 511 V9.0.2 (032003)
EN 300 328 V1.6.1 (112004)
EN 301 9081 V2.2.1 (102003)
EN 301 9082 V3.2.1 (062006)

We hereby declare that [all essential radio test suites have been carried 
out and that] the above named product is in conformity to all the 
essential requirements of Directive 1999/5/EC.

The conformity assessment procedure referred to in Article 10 and 
detailed in Annex[] of Directive 1999/5/EC has been followed with the 
involvement of the following Notified Body(ies):

BABT, Balfour House, Churchfield Road,
Walton-on-Thames, Surrey, KT12 2TD, UK*
Identification mark: 0168

The technical documentation kept at :

Samsung Electronics QA Lab.

which will be made available upon request.
(Representative in the EU)

Samsung Electronics Euro QA Lab.
Blackbushe Business Park, Saxony Way,
Yateley, Hampshire, GU46 6GG, UK*
2007.08.14 Yong-Sang Park / S. Manager
(place and date of issue) (name and signature of authorised person)

* It is not the address of Samsung Service Centre. For the address or the 
phone number of Samsung Service Centre, see the warranty card or contact 
the retailer where you purchased your phone.

Position only
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